
 

บทที ่3 

การออกแบบโครงงาน 
 

3.1 โครงสร้างของชุดปฏิบัติการ 
 

 
 
ภาพที่ 3.1 ขั้นตอนการด าเนินการของโครงงาน 

ผู้ใช/้ผู้ฝึก 

ใบประเมินก่อนการ
ใช้ 

ชุดปฏิบัติการ 

ใบประเมินหลังการใช้ 

สื่อการสอน ใบงานแบบฝึกหัด 

ชุด Mini Project 
เฉลยใบงานผลการ

ทดลอง 
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ในส่วนของบทนี้จะกล่าวถึงการออกแบบซึ่งจะน าเสนอโครงงานตามผัง Diagram ดังต่อไปนี้ 
3.1.1 รายละเอียดของ Diagram มีดังนี ้

 
1. ผู้ใช้/ผู้ฝึก คือผู้ที่เข้ามารับการใช้หรือฝึกใช้ตัวชุดปฏิบัติการการทดลองด้วย  PLC จะ

ประกอบไปด้วยนักเรียน นักศึกษา และบุคคลทั่วไปจ านวน 30 คน 
 
2. ใบประเมินก่อน-หลัง เพื่อวัดและประเมินความรู้ก่อนและหลังใช้ชุดปฏิบัติการการ

ทดลองด้วย PLC 
 

3. สื่อการสอน จะเป็นโปรแกรมสอนการใช้พื้นฐานต่างๆ ไม่ว่าจะเป็นการใช้ฟังก์ชัน
พื้นฐาน วิธีเปิด File, Save File, ป้อนโปรแกรมเข้า PLC และอ่ืนๆ 

 
4. เนื้อหาใบงานในชุดปฏิบัติการการทดลอง จะมีใบงานทั้งหมด 4 ใบงานโดยมี    ใบ

งานในชุดปฏิบัติการการทดลองจะมีดังนี้ 
 

 การควบคุมการเปิด-ปิดประตูโรงรถ 
 การควบคุมไฟวิ่ง 
 การควบคุมมอเตอร์กลับทิศทางหมุนในระบบอัตโนมัติ 
 การควบคุมการเติมน้ าในอ่างกักเก็บน้ า 

 
5. ชุด Mini Project จะอยู่ในใบงานที่ 4 จะแบ่งออกเป็น 2 ส่วนคือส่วนของตัว

โปรแกรมที่ใช้ และส่วนของชิ้นงานที่น ามาแสดงเพื่อให้ดูการท างานจริงในการใช้  
PLC ควบคุมระบบ 

 
6. เฉลยใบงานการทดลอง จะเฉลยใบงานทั้ง 4 ใบงานว่าผู้ฝึกหรือผู้ใช้ได้หัดท าเองจาก

ใบงานแล้วได้ผลตรงการที่ท าเสร็จออกมาแล้วหรือไม่ 
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3.2 ใบประเมินความรู้ 
 

 แบบทดสอบก่อน-หลังการเข้าใช้ชุดปฏิบัติการ  
 

ค าสั่ง  
 

1.ให้นักเรียนท าเคร่ืองหมายกากบาทลงบนกระดาษค าตอบข้อที่ถูกต้องที่สุดเพียงข้อเดียว  
2. ท าแบบทดสอบทุกข้อที่ก าหนดให้ 
3. ข้อสอบข้อละ 1 คะแนน มีจ านวน 20 ข้อ 
 
โจทย์ 
 
ข้อ 1-2 วัดความรู้โครงสร้างพื้นฐานของ PLC 
 
1. โครงสร้างพื้นฐานของ PLC ประกอบด้วยส่วนหลักจ านวนเท่าไร 
ก. 3 ส่วน      ข. 4 ส่วน 
ค. 5 ส่วน      ง. 6 ส่วน 
 
2. ส่วนประกอบใดของ PLCที่ท าหน้าที่ค านวณและควบคุมการท างานของ PLC ซึ่งเปรียบเสมือน
สมองของ PLC 
ก. ภาคอินพุต     ข. ตัวประมวลผลหรือ CPU 
ค.หน่วยความจ า     ง. ภาคเอาต์พุต 
 
ข้อ 3-6 วัดความรู้ด้านความเป็นมาของ PLC  
 
3. PLC ผลิตขึ้นคร้ังแรกใช้กับงานใด  
ก. งานระบบไฟฟ้าของเขื่อน     ข. งานของโรงงานผลิตรถยนต์  
ค. งานระบบขนส่ง      ง. งานผลิตอาหาร  
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4. ในปี ค.ศ. 1980 – 1989 มีการเปลี่ยนแปลงเกี่ยวกับ PLC เร่ืองใดบ้าง  
ก. ผลิตซอฟท์แวร์ที่ PLC ติดต่อกับคอมพิวเตอร์ได้    
ข. ใช้ภาษาที่เป็นมาตรฐานเดียวกัน 
ค. เร่ิมใช้อินพุตแบบอนาล็อก     
ง. การติดต่อระหว่าง PLC ระหว่าง PLC 
 
5. เหตุใดเมื่อใช้ PLC ท าให้ระบบงานเล็กลง  
ก. ตัว PLC มีขนาดเล็ก 
ข. PLC ท างานในรูปของซอฟท์แวร์ที่ตรงกับสภาพจริง  
ค. PLC เปลี่ยนแปลงวงจรได้ง่าย  
ง. ตรวจสอบตัวเองได้  
 
6. ข้อดีของระบบ PLC เมื่อเทียบกับระบบรีเลย์  
ก. เป็นระบบที่ควบคุมได้ง่าย     ข. ลดภาระเร่ืองกระแสไฟฟ้า  
ค. การบ ารุงรักษาต่างๆ    ง. เปลี่ยนแปลงวงจรได้ง่าย  
 
ข้อ 7-15 วัดความรู้ท่ัวไปของ PLC 
 
7. ข้อใดถูกต้องที่สุด  
ก. ระบบรีเลย์มีฟังก์ชั่นในการตรวจสอบตัวเอง  
ข. ระบบ PLC มีอายุการใช้งานนานกว่าระบบรีเลย์  
ค. PLC สามารถต่อกับอุปกรณ์อินพุตได้หลายแบบ  
ง. ระบบรีเลย์ต่อกับเคร่ืองพิมพ์ได้ 2 
 
8.ข้อใดคือ PLC ที่ใช้ในปัจจุบัน 
ก. Omron , Keyence     ข. Unitronics , ABC  
ค. LG , Norton      ง. Allen Bradley , Magita 
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9. ข้อใดคือ Micro PLC  
ก. PLC ที่มีขนาด I/O 100 จุด     ข. PLC ยี่ห้อ Omron  
ค. PLC ที่มีขนาด I/O 640 จุด     ง. PLC ที่มีขนาด I/O 2048 จุด 
 
10. ลักษณะงานใดที่เหมาะสมกับ PLC 
ก. งานขนาดเล็กเพราะ PLC ทนกระแสไฟฟ้าได้ต่ า 
ข. งานที่มีการเปิดและปิดบ่อยคร้ัง 
ค. งานที่ต้องการความถูกต้องของต าแหน่ง 
ง. งานที่มีการเปลี่ยนแปลงวงจรบ่อยคร้ัง 
 
11. งานใดไม่เหมาะสมกับระบบ PLC 
ก. งานที่ต้องการขยายงานในอนาคต  
ข. งานที่ต้องมีการรายงานผล  
ค. ระบบงานขนาดเล็ก  
ง. งานที่ต้องการเก็บข้อมูล  
 
12. งานใดเหมาะสมกับ PLC ชนิดบล็อก  
ก. งานที่ต้องการเปลี่ยนแปลงเงื่อนไขบ่อย  
ข. งานที่มีเอาต์พุตจ านวนมาก  
ค. ระบบงานที่มีขนาดใหญ่ มีการประมวลผลเร็ว  
ง. ระบบงานที่มีขนาดเล็ก ไม่ต้องการความเร็วในการประมวลผลสูง  
 
13. งานใดเหมาะสมกับ PLC ชนิดโมดูล  
ก. งานที่ต้องการเปลี่ยนแปลงเงื่อนไขบ่อย  
ข. ระบบงานที่มีขนาดใหญ่ ต้องการความเร็วในการประมวลผลสูง  
ค. งานที่มีเอาต์พุตจ านวนมาก  
ง. ระบบงานที่มีขนาดเล็ก ไม่ต้องการความเร็วในการประมวลผลสูง 
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14. ข้อใดไม่ใช่รูปของ PLC 

ก.      ข.  

ค.      ง.  
 
15. อุปกรณ์ข้อใดเป็นอุปกรณ์เอาต์พุต  
ก. Photo Switch ,Limit Switch    ข. Photo Switch, Lamp  
ค. Lamp, Limit Switch     ง. Solenoid Valve, Relay  
 
ข้อ 16-20 วัดความรู้พื้นฐานการใช้โปรแกรมใน Siemens LOGO! Soft Comfort 
 

16.  จากรูปในภาพคือฟังก์ชันใด 
ก. Input      ข. Flag 
ค. Output      ง. Status 0 
 

17.  จากรูปในภาพคือฟังก์ชันใด 
ก. Input      ข. Flag 
ค. Output      ง. Status 0 
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18.  จากรูปในภาพคือฟังก์ชันใด 
ก. Message texts     ข. Pulse Relay 
ค. On Relay     ง. Latching Relay 
 

19.  จากรูปในภาพคือฟังก์ชันใด 
ก. Message texts     ข. Pulse Relay 
ค. On Relay     ง. Latching Relay 
 

20.  จากรูปในภาพคือฟังก์ชันใด 
ก. Message texts     ข. Pulse Relay 
ค. On Relay     ง. Latching Relay 
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3.3 ใบงานในการทดลอง 
 

3.3.1 ใบงานการทดลองท่ี 1 
 

การทดลองที ่1 
การควบคุมการเปิด-ปิดประตูโรงรถ 

 
วัตถุประสงค์ 
 
 1. ให้นักศึกษาเข้าใจหลักการท างานการจอดรถในโรงรถ 
 2. ให้นักศึกษาเข้าใจการท างานของเซนเซอร์และ Motor ในระบบควบคุม 
 3. สามารถน า PLC ไปประยุกต์ใช้การท างานอ่ืนๆได้ 
 4. รู้จักการใช้ฟังก์ชัน Latching Relay 
 
ทฤษฎี 
 
PLC = Programmable Logic Controller (LOGO! 230RC) 
 

 
 

ภาพที่ 3.2 รูปของ PLC รุ่น LOGO! 230RC 



41 

 เป็นอุปกรณ์ที่คิดค้นขึ้นมาใช้ควบคุมการท างานแบบอัตโนมัติ ท างานโดยรับค าสั่งที่เขียน
ขึ้นมาโปรแกรมผ่านโปรแกรมที่ชื่อว่า Siemens LOGO! Soft Comfort โดยจะเขียนเป็น Ladder 
หรือ Block Diagram ก็ได้และน าไปสั่งอุปกรณ์ที่ต่อรอที่เอาต์พุตอีกที 
 
โครงสร้างพื้นฐานของ PLC 
 

 
 
ภาพที่ 3.3 โครงสร้างพื้นฐานของ PLC 
 
ประกอบด้วย 9 ส่วนดังนี ้
 

1. อุปกรณ์อินพุต คืออุปกรณ์ต่างๆที่ใช้ในการท างานของระบบนั้นๆ และน ามาต่อเพื่อส่ง
สัญญาณที่ได้ไปภาคอินพุต 

 
2. ภาคอินพุต คือภาคที่จะรับสัญญาณจากอุปกรณ์อินพุตมาและส่งสัญญาณที่ได้มาไปสู่

หน่วยประมวลผล (CPU) เพื่อเข้าสู่กระบวนการการท างานต่อไปโดยสัญญาณที่ได้จะอยู่ใน
รูปแบบดิจิตอลหรือแอนาล๊อก 
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3. หน่วยความจ า ท าหน้าที่เก็บรักษาโปรแกรมและข้อมูลต่างๆประกอบด้วย ROM จะเก็บ
โปรแกรมการท างานที่ใช้ในการปฏิบัติงานจริง ส่วน RAM จะท าหน้าที่เก็บโปรแกรมของ
ผู้ใช้แต่ไม่ถาวรเหมาะสมกับใช้ทดสอบโปรแกรม 

4. หน่วยประมวลผล (CPU) ท าหน้าที่ค านวณและควบคุมอุปกรณ์ต่างๆ ซึ่งเปรียบเหมือน
สมองของ PLC ที่ของควบคุมและสั่งการสิ่งต่างๆภายในประกอบด้วย วงจรลอจิกหลาย
ชนิดและมีไมโครโปรเซสเซอร์เบส (Micro Processor Based) ใช้แทนอุปกรณ์จ าพวกรีเลย์ 
เคาน์เตอร์/ไทม์เมอร์ และซีเควนเซอร์ เพื่อให้ผู้ใช้สามารถออกแบบวงจรได้ 

 
5. ภาคเอาต์พุต คือภาคที่จะรับสัญญาณที่ประมวลผลแล้วจากหน่วยประมวลผล (CPU) แล้ว

ส่งสัญญาณไปยังอุปกรณ์เอาท์พุตต่างๆ 
 

6. อุปกรณ์เอาท์พุต คืออุปกรณ์ต่างๆที่จะสั่งให้ท างานหรือน าไปใช้ โดยจะรับสัญญาณจาก
ภาคเอาต์พุตมาว่าจะให้ท างานอย่างไร เมื่อไร 

 
7. เคร่ืองป้อนโปรแกรม ท าหน้าที่ป้อนโปรแกรมที่เราเขียนเข้าสู่หน่วยความจ า แต่ PLC ที่ใช้

คือรุ่น LOGO! 230RC นี้จะไม่ต้องใช้เคร่ืองป้อนโปรแกรม แต่ใช้สาย LOGO! USB PC 
Cable แทน 

 
8. คอมพิวเตอร์ ท าหน้าที่เขียนค าสั่งต่างๆที่จะน าไปรับและสั่งอุปกรณ์ที่มาต่อเข้ากับ PLC รุ่น 

LOGO! 230RC นี้ โดยจะน าโปรแกรมที่เขียนขึ้นได้ผ่านสาย LOGO! USB PC-Cable จาก
คอมพิวเตอร์สู่ PLC รุ่น LOGO! 230RC  

 
9. ภาคจ่ายพลังงาน ท าหน้าที่จ่ายพลังงานและรักษาระดับแรงดันไฟให้กับ  PLC ทั้งใน

หน่วยความจ าและหน่วยประมวลผล 
 
ภาษาที่ใช้การเขียนโปรแกรม PLC ส าหรับรุ่น LOGO! 230RC มี 2 แบบคือ 
 

1. Ladder Diagram คือไดอะแกรมที่จัดเป็นภาษาสัญญาณที่สามารถดูตามโครงสร้างแล้ว
เข้าใจการท างานโดยการเขียนแลดเดอร์เหมือนกับการสร้างไดอะแกรมการเดินสายไฟเป็นที่นิยมใช้
กันมากโดยจะเร่ิมจากซ้ายไปขวา บนลงล่างดังรูป 
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ภาพที่ 3.4 Ladder Diagram 
 

2. Block Diagram คือไดอะแกรมที่เหมาะกับคนที่มีพื้นฐานทางด้านอิเล็กทรอนิกส์หรือ
ดิจิตอลซึ่งจะเป็นการสร้าง Logic Boxes เหมือนกับน า Box มาต่อๆกันดังรูป 

 

 
 
ภาพที่ 3.5 Block Diagram 
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การใช้งานพื้นฐานโปรแกรมSiemens LOGO! Soft Comfort 
 
 
 
 

 
 
 
 
 
ภาพที่ 3.6 โปรแกรม Siemens LOGO! Soft Comfort 
 
 
 
 
 
 
 
 

กลุ่มฟังก์ชันต่าง 

ส าหรับควบคุม 

เมนูบาร์ พื้นที่ส าหรับการเขียน

โปรแกรม 

แสดงสถานะของอินพุตและ

เอาต์พุต 
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วิธีเปิดแฟ้มใหม่ File > New หรือคลิก ตามรูป 
 

 
 
ภาพที่ 3.7 วิธีเปิดแฟ้มใหม่ 
 
วิธีการบันทึกโดยกด File > Save หรือ File > Save As หรือคลิก ตามรูป 
 

 
 
ภาพที่ 3.8 วิธีการบันทึก 
 

คลิก 

คลิก 
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วิธีการทดสอบโปรแกรม Tools > Simulation หรือ กด F3 หรือคลิก ตามรูป 
 

 
 
ภาพที่ 3.9 วิธีการทดสอบโปรแกรม 
 
ฟังก์ชันท่ีใช้ในการทดลอง 
 

1.  Input 
Input1 หรือ I1 
 

2.  Output 
Output1 หรือ Q1 
 

คลิก 
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3. AND 
Q1 จะติดเมื่อมีอินพุตท างานทั้งหมด 
 

4. XOR 
Q1 จะติดเมื่อมีอินพุตตัวไหนตัวหนึ่งท างาน 
 

5.  Latching Relay 
ท างานเมื่อมีสัญญาณเข้าที่ขา S ก็จะส่งสัญญาณออกไปตลอด แต่ถ้ามีสัญญาณเข้าที่ขา R จะไม่ให้
ส่งสัญญาณออกไปตลอด 

 
อุปกรณ์การทดลอง 

 
1. สื่อการสอน 
2. คอมพิวเตอร์ 
3. โปรแกรม LOGO 

 
โจทย์ 

 
 เมื่อมีรถผ่าน Sensor1 จะสั่งให้ Motor ท างานดึงประตูขึ้นแล้วพอรถผ่านไปที่ Sensor2 ก็
จะสั่งให้ Motor ท างานให้ประตูปิดลงมา (จะต้องไม่เห็น Sensor อีกอันหนึ่งถึงจะสั่ง Motor ให้
ท างาน) 
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ขั้นตอนการทดลอง 

 
1. ดูสื่อการสอนเพื่อรู้ฟังก์ชันและวิธีใช้ขั้นพื้นฐาน 
2. ให้นักศึกษาจากโจทย์ที่ให้ 
3. ให้นักศึกษาลองเขียนตาม Block Diagram ที่ให้ 

 

 
 
ภาพที่ 3.10 Block Diagram ของการทดลองการควบคุมการเปิด-ปิดประตูโรงรถ 
 
ให้ศึกษาจากฟังก์ชันในตาราง 
 
ตารางที่ 3.1 ฟังก์ชันที่ใช้ในการทดลองการควบคุมการเปิด-ปิดประตูโรงรถ 
 

Input 
Switch ON I1 
Switch OFF I2 

Sensor switch 1 I3 
Sensor switch 2 I4 
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ตารางที่ 3.1 ฟังก์ชันที่ใช้ในการทดลองการควบคุมการเปิด-ปิดประตูโรงรถ (ต่อ) 
 

ฟังก์ชัน 
AND & 
XOR =1 

Latching Relay RS 
Output 

Motor Q1 
 
บันทึกผลการทดลอง 
 
ตารางที่ 3.2 ผลการทดลองการควบคุมการเปิด-ปิดประตูโรงรถ 
 

I1 I2 I3 I4 Q1 
0 0 0 0  
0 0 0 1  
0 0 1 0  
0 0 1 1  
0 1 0 0  
0 1 0 1  
0 1 1 0  
0 1 1 1  
1 0 0 0  
1 0 0 1  
1 0 1 0  
1 0 1 1  
1 1 0 0  
1 1 0 1  
1 1 1 0  
1 1 1 1  
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อธิบายและสรุปผลการทดลองท างาน 
 
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
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3.3.2 ใบงานการทดลองท่ี 2 
 

การทดลองที ่2 
การควบคุมมอเตอร์กลับทิศทางหมุนในระบบอัตโนมัติ 

 
วัตถุประสงค์ 
 

1. ให้นักศึกษาเรียนรู้การใช้ PLC ในการควบคุมมอเตอร์กลับทิศทางหมุนได้ 
2. สามารถใช้ PLC ในการสั่งควบคุมแบบอัตโนมัติได้ 
3. สามารถใช้ PLC ในการควบคุมมอเตอร์สตาร์-เดลต้าได้ 
4. ให้นักศึกษาเข้าใจการท างานของ Timer 

 
ฟังก์ชันท่ีใช้ในการทดลอง 
 

1.  Input 
Input1 หรือ I1 
 

2.  Output 
Output1 หรือ Q1 
 

3.  Flag 
เป็นตัวแทนตัวอ่ืนๆในการเก็บค่า ส่วนใหญ่จะใช้เก็บค่าของเอาต์พุตเพื่อน าสัญญาณที่เก็บไปใช้ต่อ 
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4.  NOT 
ท าหน้าที่กลับค่าสัญญาณเช่น สัญญาณเข้ามาจะไม่ส่งสัญญาณออกไป แต่เมื่อไม่มีสัญญาณเข้ามาก็
จะส่งสัญญาณออกไป 
 

5. AND 
Q1 จะติดเมื่อมีอินพุตท างานทั้งหมด 
 

6. On Relay 
ท างานเมื่อมีสัญญาณเข้ามา และจะหน่วงเวลาตามที่ก าหนดก่อนที่จะส่งสัญญาณออกไป 
 

7. Off Relay 
ท างานเมื่อมีสัญญาณเข้ามาที่ขาด้านบนจะส่งสัญญาณออกไปทันที และเมื่อสัญญาณที่ส่งมาหายก็
จะหน่วงเวลาตามที่ก าหนดก่อนที่จะตัดสัญญาณที่ส่งออกไป และถ้ามีสัญญาณเข้ามาที่ขาด้านล่างก็
จะตัดสัญญาณที่ส่งออกไปจนกว่าขาด้านล่างจะไม่มีสัญญาณส่งมา 
 

8.  Latching Relay 
ท างานเมื่อมีสัญญาณเข้าที่ขา S ก็จะส่งสัญญาณออกไปตลอด แต่ถ้ามีสัญญาณเข้าที่ขา R จะไม่ให้
ส่งสัญญาณออกไปตลอด 
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9.  Message texts 
ท างานเมื่อมีสัญญาณเข้ามาจะแสดงข้อความและสามารถเอาสัญญาณออกไปใช้ได้ 
 
อุปกรณ์การทดลอง 
 

1. สื่อการสอน 
2. คอมพิวเตอร์ 
3. โปรแกรม LOGO 

 
โจทย์  
 
 มี Switch ON-OFF เปิด-ปิดแต่เมื่อกดเปิดเร่ิมท างานตอนแรก Motor จะท างานแบบ Star 
อยู่ 3 นาทีพอถึงเปิดไป 3 นาทีจะหยุด และทิ้งช่วงเวลาประมาณ 3 นาทีก่อนที่ Motor จะเร่ิมท างาน
อีกคร้ังแต่จะท างานแบบ Deltar (ช่วงการหน่วงเวลาสามารถปรับเปลี่ยนได้ตามความต้องการ และ
ให้ใช้ Message Texts แสดงว่า Motor ท างานแบบใด) 
 
ขั้นตอนการทดลอง 
 

1. ดูสื่อการสอนเพื่อรู้ฟังก์ชันและวิธีใช้ขั้นพื้นฐาน 
2. ให้นักศึกษาจากโจทย์ที่ให้ 
3. ให้นักศึกษาลองเขียนตาม Block Diagram ที่ให้ 
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ภาพที่ 3.11 Block Diagram ของการควบคุมมอเตอร์กลับทิศทางหมุนในระบบอัตโนมัติ 
 
ให้ศึกษาจากฟังก์ชันจากตาราง 
 
ตารางที่ 3.3 ฟังก์ชันที่ใช้ในการทดลองการควบคุมมอเตอร์กลับทิศทางหมุนในระบบอัตโนมัติ 
 

Input 
Switch ON I1 
Switch OFF I2 

Flag M1 
ฟังก์ชัน 

AND & 
NOT 1 

Latching Relay RS 
ON Relay อยู่ในส่วนของ Timer 
OFF Relay อยู่ในส่วนของ Timer 

Message Text อยู่ในส่วนของ Miscellaneous 
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ตารางที่ 3.3 ฟังก์ชันที่ใช้ในการทดลองการควบคุมมอเตอร์กลับทิศทางหมุนในระบบอัตโนมัติ 
(ต่อ) 
 

Output 
Motor Star Q1 

Motor Delta Q2 
 
บันทึกผลการทดลอง 
 
ตารางที่ 3.4 ผลการทดลองการควบคุมมอเตอร์กลับทิศทางหมุนในระบบอัตโนมัติ 
 

I1 I2 Q1 Q2 เมื่อผ่านไป  
3 วินาที 

Q1 Q2 

0 0      
0 1      
1 0      
1 1      

 
อธิบายและสรุปผลการทดลองท างาน 
 
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
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………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
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3.3.3 ใบงานการทดลองท่ี 3 
 

การทดลองที ่3 
การควบคุมไฟวิ่ง 

วัตถุประสงค์ 
 

1. ให้นักศึกษาเข้าใจค าสั่งและเรียนรู้ฟังก์ชันพื้นฐานของ PLC 
2. ใช้นักศึกษาเข้าใจการท างานการวน Loop 
3. ให้นักศึกษาสามารถเขียนโปรแกรมควบคุมอุปกรณ์อินพุต เอาต์พุตได้ 
4. ให้รู้จัก Pulse Relay 

 
ฟังก์ชันท่ีใช้ในการทดลอง 
 

1.  Input 
Input1 หรือ I1 
 

2.  Output 
Output1 หรือ Q1 
 

3.  Flag 
เป็นตัวแทนตัวอ่ืนๆในการเก็บค่า ส่วนใหญ่จะใช้เก็บค่าของเอาต์พุตเพื่อน าสัญญาณที่เก็บไปใช้ต่อ 
 



58 

4.  NOT 
ท าหน้าที่กลับค่าสัญญาณเช่น สัญญาณเข้ามาจะไม่ส่งสัญญาณออกไป แต่เมื่อไม่มีสัญญาณเข้ามาก็
จะส่งสัญญาณออกไป 
 

5. Off Relay 
ท างานเมื่อมีสัญญาณเข้ามาที่ขาด้านบนจะส่งสัญญาณออกไปทันที และเมื่อสัญญาณท่ส่งมาหายก็
จะหน่วงเวลาตามที่ก าหนดก่อนที่จะตัดสัญญาณที่ส่งออกไป และถ้ามีสัญญาณเข้ามาที่ขาด้านล่างก็
จะตัดสัญญาณที่ส่งออกไปจนกว่าขาด้านล่างจะไม่มีสัญญาณส่งมา 
 

6.  Latching Relay 
ท างานเมื่อมีสัญญาณเข้าที่ขา S ก็จะส่งสัญญาณออกไปตลอด แต่ถ้ามีสัญญาณเข้าที่ขา R จะไม่ให้
ส่งสัญญาณออกไปตลอด 
 

7.  Pulse Relay 
ท างานเมื่อมีสัญญาณเข้าที่ขาแรกก็จะส่งสัญญาณออก แต่เมื่อมีสัญญาณมาอีกก็จะตัดสัญญาณที่
ส่งออกไป ถ้าสัญญาณเข้าที่ขากลางกี่คร้ังก็ตามสัญญาณจะส่งออกตลอด แต่เมื่อมีสัญญาณเข้าขา
สุดท้ายก็จะตัดสัญญาณไม่ว่ายังไงก็ตาม 
 
 
 
 
 



59 

อุปกรณ์การทดลอง 
 

1. สื่อการสอน 
2. คอมพิวเตอร์ 
3. โปรแกรม LOGO 

 
โจทย์ 
 

มี Switch ON-OFF เปิด-ปิด เมื่อกดเปิดโปรแกรมจะเร่ิมท างานโดยไฟหลอดแรกจะติด
และท างานไป 3 วินาทีก่อนจะดับและหลอดสองจะติดแทน โดยทีหลอดสองติดอยู่  3 วินาทีก่อนจะ
ดับไป พอดับหลอดไฟดวงต่อไปจะติดแทน และเป็นแบบนี้ไปเร่ือยๆจนถึงหลอดสุดท้ายและ
กลับมาท าซ้ าที่หลอดแรก (ช่วงการหน่วงเวลาสามารถปรับเปลี่ยนได้ตามต้องการ) 

 
ขั้นตอนการทดลอง 
 

1. ดูสื่อการสอนเพื่อรู้ฟังก์ชันและวิธีใช้ขั้นพื้นฐาน 
2. ให้นักศึกษาจากโจทย์ที่ให้ 
3. ให้นักศึกษาลองเขียนตาม Block Diagram ที่ให้ 

 

 
 

ภาพที่ 3.12 Block Diagram ของการทดลองการควบคุมไฟวิ่ง 
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ให้ศึกษาจากฟังก์ชันในตาราง 
 
ตารางที่ 3.5 ฟังก์ชันที่ใช้ในการทดลองการควบคุมไฟวิ่ง 
 

Input 
Switch ON I1 
Switch OFF I2 

Flag 1 M1 
Flag 2 M2 
Flag 3 M3 

ฟังก์ชัน 
NOT 1 

Latching Relay RS 
Pulse Relay อยู่ในส่วนของ Miscellaneous 

Output 
Lamp 1 Q1 
Lamp 2 Q2 
Lamp 3 Q3 

 
บันทึกผลการทดลอง 
 
ตารางที่ 3.6 ผลการทดลองการควบคุมไฟวิ่ง 
 

I1 I2 Q1 Q2 Q3 เมื่อผ่าน
ไป         

3 วินาที 

Q1 Q2 Q3 

0 0        
0 1        
1 0        
1 1        
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อธิบายและสรุปผลการทดลองท างาน 
 
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
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3.3.4 ใบงานการทดลองท่ี4  
 

การทดลองที ่4 
การควบคุมการเติมน้ าในอ่างกักเก็บน้ า 

 
วัตถุประสงค์ 
 

1. ให้นักศึกษาเข้าใจค าสั่งของ PLC ในการแบบ Complex 
2. ให้นักศึกษาเข้าใจการท างานของ Flow 
3. สามารถน าไปประยุกต์หรือพัฒนาในการท างาน ที่ใกล้เคียงหรือเกี่ยวข้องได้ 

 
ฟังก์ชันท่ีใช้ในการทดลอง 
 

1.  Input 
Input1 หรือ I1 
 

2.  Output 
Output1 หรือ Q1 
 

3.  Flag 
เป็นตัวแทนตัวอ่ืนๆในการเก็บค่า ส่วนใหญ่จะใช้เก็บค่าของเอาต์พุตเพื่อน าสัญญาณที่เก็บไปใช้ต่อ 
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4. AND 
Q1 จะติดเมื่อมีอินพุตท างานทั้งหมด 
 

5.  NOR 
Q1 จะติดเมื่อไม่มีสัญญาณอินพุตเข้ามา 
 

6.  OR 
Q1 จะติดเมื่อมีสัญญาณอินพุตเข้ามา 1 สัญญาณ 
 

7. XOR 
Q1 จะติดเมื่อมีอินพุตตัวไหนตัวหนึ่งท างาน 
 

8.  NOT 
ท าหน้าที่กลับค่าสัญญาณเช่น สัญญาณเข้ามาจะไม่ส่งสัญญาณออกไป แต่เมื่อไม่มีสัญญาณเข้ามาก็
จะส่งสัญญาณออกไป 
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9. Off Relay 
ท างานเมื่อมีสัญญาณเข้ามาที่ขาด้านบนจะส่งสัญญาณออกไปทันที และเมื่อสัญญาณที่ส่งมาหายก็
จะหน่วงเวลาตามที่ก าหนดก่อนที่จะตัดสัญญาณที่ส่งออกไป และถ้ามีสัญญาณเข้ามาที่ขาด้านล่างก็
จะตัดสัญญาณที่ส่งออกไปจนกว่าขาด้านล่างจะไม่มีสัญญาณส่งมา 
 

10.  Latching Relay 
ท างานเมื่อมีสัญญาณเข้าที่ขา S ก็จะส่งสัญญาณออกไปตลอด แต่ถ้ามีสัญญาณเข้าที่ขา R จะไม่ให้
ส่งสัญญาณออกไปตลอด 
 

11.  Message texts 
ท างานเมื่อมีสัญญาณเข้ามาจะแสดงข้อความและสามารถเอาสัญญาณออกไปใช้ได้ 
 
อุปกรณ์การทดลอง 
 

1. สื่อการสอนคอมพิวเตอร์ 
2. โปรแกรม LOGO 
3. ชุดปฏิบัติการการทดลองด้วย PLC 

 
โจทย์  
 
 มี Switch ON-OFF เปิด-ปิด เมื่อเร่ิมท างานก็จะมาดูที่ Level Switch1 และ Level Switch2 
มีน้ าหรือไม่ ถ้าไม่มี ก็จะเติมน้ า ถ้ามีดูว่าน้ าอยู่ที่ Level Switch ไหนถ้าอยู่ที่ Level Switch2 ก็จะไม่
เติมแต่ถ้าอยู่ที่ Level Switch1 ก็จะเติมจนกว่าถึง Level Switch2 โดย Level Switch 2 จะไปสั่ง 
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Pumb ให้ท างานเพื่อเติมน้ าโดยจะมี Flow ท าหน้าที่คอยเช็คว่ามีน้ าผ่านไหม ถ้าไม่มีก็จะสั่งให้หยุด
ท างาน ถ้ามีก็ท างานตามปกติ 
 
ขั้นตอนการทดลอง 
 

1. ดูสื่อการสอนเพื่อรู้ฟังก์ชันและวิธีใช้ขั้นพื้นฐาน 
2. ให้นักศึกษาจากโจทย์ที่ให้ 
3. ให้นักศึกษาลองดูและลองใช้จากตัว Mini Project ว่าระบบนี้ท างานอย่างไรแล้วเขียน

อธิบายการท างานว่าระบบท างานอย่างไรอย่างละเอียด 
4. ลองเขียน Block Diagram หรือ Ladder Diagram โดยศึกษาจากตัว Mini Project ว่าท างาน

อย่างไร แล้วเขียนออกมาว่าท างานได้ตาม Mini Project หรือไม่โดยใช้ฟังก์ชันจากที่
ก าหนดให้ไว้ พร้อมทั้งอธิบายการท างานอย่างละเอียดในการใช้ฟังก์ชันแต่ละตัวในการ
เขียน Block Diagram หรือ Ladder Diagram 

 
ตารางที่ 3.7 ฟังก์ชันที่ใช้ในการทดลองการควบคุมการเติมน้ าในอ่างกักเก็บน้ า 
 

Input 
Switch ON I1 
Switch OFF I2 

Level Switch 1 I3 
Level Switch 2 I4 

Flow I5 
Flag 1 M1 
Flag 2 M2 

ฟังก์ชัน 
NOR >=1 Not 
OR >=1 

AND & 
XOR =1 
NOT 1 
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ตารางที่ 3.7 ฟังก์ชันที่ใช้ในการทดลองการควบคุมการเติมน้ าในอ่างกักเก็บน้ า (ต่อ) 
 

Latching Relay RS 
OFF Relay อยู่ในส่วนของ Timer 

Output 
Motor Q1 

 
อธิบายการท างานของตัวงาน Mini Project 
 
………………………………………………………………………………………………………
……………………………………………………………………………………………………….
.………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
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บันทึกผลการทดลอง  
 
ตารางที่ 3.8 ผลการทดลองการควบคุมการเติมน้ าในอ่างกักเก็บน้ า 
 

I1 I2 I3 I4 I5 Q1 
0 0 0 0 0  
0 0 0 0 1  
0 0 0 1 0  
0 0 0 1 1  
0 0 1 0 0  
0 0 1 0 1  
0 0 1 1 0  
0 0 1 1 1  
0 1 0 0 0  
0 1 0 0 1  
0 1 0 1 0  
0 1 0 1 1  
0 1 1 0 0  
0 1 1 0 1  
0 1 1 1 0  
0 1 1 1 1  
1 0 0 0 0  
1 0 0 0 1  
1 0 0 1 0  
1 0 0 1 1  
1 0 1 0 0  
1 0 1 0 1  
1 0 1 1 0  
1 0 1 1 1  
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ตารางที่ 3.8 ผลการทดลองการควบคุมการเติมน้ าในอ่างกักเก็บน้ า (ต่อ) 
 

1 1 0 0 0  
1 1 0 0 1  
1 1 0 1 0  
1 1 0 1 1  
1 1 1 0 0  
1 1 1 0 1  
1 1 1 1 0  
1 1 1 1 1  

 
อธิบายและสรุปผลการทดลองท างาน 
 
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
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………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
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3.4 การออกแบบ Mini Project  
 

การออกแบบ Mini Project จะแบ่งออกเป็น 2 ส่วนคือในส่วนของใบงานที่ไว้เขียน
ซอร์ฟแวร์ และในส่วนของโครงงานที่เป็นฮาร์ดแวร์โดยส่วนของฮาร์ดแวร์จะแบ่งออกเป็น 7 ส่วน
ต่างๆคือ 
 
 ส่วนของตู้ควบคุม 
 ส่วนของตู้กักเก็บน้ า 
 ส่วนของอุปกรณ์ Level Switch 
 ส่วนของอุปกรณ์ Flow 
 ส่วนของปั๊มน้ า 
 ส่วนของตู้น้ าที่ปั๊มน้ าย้อนกลับไปที่อ่างกักเก็บน้ า 
 ส่วนของโครงสร้างชั้นโชว์ 

 
3.4.1 รูปภาพแสดงการออกแบบ 

 

 
 
ภาพที่ 3.13 ลักษณะของ Mini project 
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จากรูปภาพมีรายละเอียดดังน้ี 
 

1. ตู้ Control คือตู้ที่ควบคุมอุปกรณ์ต่างๆที่อยู่ในระบบจะประกอบด้วยตัวเบรก-เกอร์ที่
ไว้ตัดวงจร, ปุ่ม Switch ON, ปุ่ม Switch OFF, ไฟแสดงผลMotor ท างาน,ไฟ-
แสดงผล PLC ท างาน และตัว PLC 

 
2. Level Switch คือตัวที่เสมือนลูกลอยมี 2 ตัวติดตั้งไว้ บน-ล่าง เพื่อไว้ตรวจสอบระดับ

น้ าในตู้เพื่อส่งสัญญาณที่ได้ไปที่ PLC 
 

3. Flow คือตัวที่ไว้ตรวจสอบการไหลผ่านของน้ า ว่ามีน้ าไหลผ่านหรือไม่และจะส่ง
สัญญาณไปที่ PLC เพื่อตัดการท างานของมอเตอร์ 

 
4. Pump คือ Motor ชนิดหนึ่งใช้เพื่อให้ pump น้ าเข้าไปที่ตู้กักเก็บน้ าตามที่ PLC สั่งมา

อีกทีหนึ่งในการออกแบบได้เลือกใช้ มอเตอร์ไฟฟ้ากระแสสลับ 1 เฟส ขนาด 0.5 
แรงม้า 370 วัตต์ 220 โวลต์เพราะมอเตอร์ขนาดนี้หาซื้อได้ตามท้องตลาด และด้วย
ความต้องการที่จะให้มอเตอร์ปั๊มน้ าเต็มอ่างน้ า 80 ลิตรภายในเวลาไม่เกิน 2 นาที จึง
ได้ท าการเลือกใช้มอเตอร์ปั๊มน้ าตัวนี้ ซึ่งมีความสามารถปั๊มน้ าได้ในเวลา 1 นาที 40 
ลิตร  

 
 
 
 
 
 
 


